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Coimbatore - 641 043, Tamil Nadu, India

AIU-AI-AADC

Seventh Short-Term Capacity Building Programme on
‘Enhancing Office Productivity: Microsoft Office and G-Suite Training
for Non-Teaching Staff’

30" September to 2" October 2023 (3 Days) - Online Mode

The Academic and Administrative Centre of the Institute floated the seventh program on
September 30, 2023 at 9.30 a.m. invoking the blessings of Divine Almighty with a prayer song.
The program was targeted at non-teaching of the higher education institutions across the country
with the objective of enhancing their office productivity through capacity training on Microsoft
Office and G-Suite training. Dr. K. Ramya, the Programme Coordinator and Nodal Officer of
AIU-AI-AADC, warmly welcomed attendees and offered a comprehensive overview of the three-
day event.
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PRESIDENTIAL
ADDRESS

DR. V. BHARATHI HARISHANKAR
VICE CHANCELLOR

Dr. V. Bharathi Harishankar, the Vice Chancellor of Avinashilingam Institute for Home Science
and Higher Education for Women in Coimbatore, delivered the presidential address on the
importance of embracing technology and transitioning to a paperless office. She emphasized that
technology, much like computers today, is a powerful tool but not more powerful than human
potential.

Dr. Harishankar underscored the significance of technology as an assistant that can efficiently
process and present data, enhancing productivity and reducing the chances of data manipulation.
She stressed the need for academic institutions to adapt to technological advancements, not only
among teaching staff but also administrative personnel.

Dr. Harishankar highlighted that a paperless office fosters efficient workflows, reducing the
temptation to overrule regulations. Furthermore, she discussed the importance of building tech-
savvy capabilities among administrators to cope with the increasing trend of online and blended
learning in educational institutions.



Dr. Harishankar encouraged participants to actively engage with technology, constantly
improving their skills, and offering input to enhance processes. She concluded with the message
that technology is a useful tool, but individuals are the ultimate decision-makers in effectively
utilizing it.

Day 1
30/09/2023 @ 11.00 am — 04:30 pm
Microsoft Word and PowerPoint

Praveen Poulose E
Engineer - Cyber Security Group
Quadrasystems.net (India) Private Limited
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The informative and hands-on session on Microsoft Word and PowerPoint was skillfully handled
by Mr. Praveen Poulose E, an Engineer from the Cyber Security Group at Quadrasystems.net
(India) Private Limited, Coimbatore.

Mr. Praveen initiated the session by introducing the fundamentals of Microsoft Office and went on
to explain the significance of Microsoft 365. He described it as a cloud-based platform designed to
enhance productivity, offering a subscription service that includes popular applications like Word,
Excel, PowerPoint, and Microsoft Teams. What sets Microsoft 365 apart is its accessibility — it
can be used on a variety of devices, from computers to mobile devices, both online and through
installations on PCs, Macs, tablets, and phones

He provided a brief historical context, noting that Microsoft first introduced Office 365 in October
2010. In 2020, it was rebranded as Microsoft 365. This transition was complemented by Mr.
Praveen's explanation of previous versions, including Office 2013, 2016, 2019, and 2021, and the
key differences between Microsoft 365 and Office 2021. He also highlighted six core applications:
Word, Excel, PowerPoint, Outlook, OneDrive, and Teams, each with its unique uses and benefits.
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Mr. Praveen emphasized Word's pivotal role as a powerful word processing software that allows
the creation, saving, and printing of documents while facilitating collaboration with others.He
provided valuable insights into the various practical applications of Microsoft Word such as
creation of resumes, notes, assignments, books, articles, email newsletters, reports, audits, legal
documents and many more.

Participants were then led through the Word interface, with each element explained in detail. From
the File tab to the Quick Access Toolbar, from the Ribbon to the ruler, participants gained a
comprehensive understanding of Word's layout and functionality. They explored elements like the
status bar, view buttons, minimize, maximize, close, scroll bar, zoom control, document name,
and dialogue box launcher, with hands-on training being an integral part of the experience.

Parts of Microsoft word

Minimize Manimize

Fila Tab | Quick Access Toolbar Title Bar Ribbon Dislog Box Launcher

Scroll Bar
Ruler Working Area Document Name
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Mr. Praveen covered all the tabs within Microsoft Word, including File, Home, Insert, Design,
Layout, References, Mailings, Review, View, and Help. He created example documents to
showcase the practical application of each feature, ensuring that participants could apply their
newfound knowledge effectively.

In the Home tab, participants learned about essential functions such as cut, copy, paste, format
painter, font type, font size, font color change, font alignment, find and replace options. Layout
tab functions, including margin settings, page orientation, size, column, page setup, indent, and
spacing, were also elucidated. Advanced options, such as spell and grammar checks, were
demonstrated in-depth.



Mailing options were also discussed, covering envelopes, labels, and mail merge processes.
Mr. Praveen explained how to select recipients and edit recipients' lists, offering a comprehensive
understanding of these important features. Step-by-step procedures for mail merges were clearly
explained and demonstrated with practical examples.

The Insert tab was the next area of focus, where participants learned to create cover pages, blank
pages, tables, insert pictures and shapes, and manage hyperlinks and bookmarks. The session also
covered how to utilize page headers, footers, and page numbers, along with creating text boxes for
enhanced document structure.

The latter part of the session shifted its focus to Microsoft PowerPoint. Mr. Praveen explained
PowerPoint as a powerful presentation software that allows users to create impactful and engaging
presentations and slideshows.

Reasons why you might need Microsoft PPT
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The PowerPoint segment was divided into five key topics: navigating the PowerPoint interface,
creating engaging presentations, managing slide transitions and animations, creating charts,
adding comments, and rehearsing timings. A live example PowerPoint presentation was created
and used to showcase all the available options, from file management to word art, inserting images,
using slide transitions, and designing slides.

Mr. Praveen also took a moment to reflect on how technology has evolved over time, emphasizing
how PowerPoint presentations have become increasingly influential in conveying information. He
highlighted the numerous advantages of using PowerPoint presentations, such as their visual
appeal and the ability to present complex ideas with clarity.

In conclusion, Mr. Praveen shared a Word tutorial link (https://edu.gcfglobal.org/en/word/#) with
participants and strongly encouraged them to practice and apply the skills they had acquired. The
session offered a thorough and practical introduction to Microsoft Word and PowerPoint,
equipping participants with the essential knowledge and skills to excel in their professional and
academic endeavors.
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Mr. Thamizharasu C, Manager of Strategic Projects at Quadrasystems.Net (India) Private Ltd,
Coimbatore served as the resoure person for Day 2. The session commenced with a

comprehensive introduction to Microsoft Excel, emphasizing its pivotal role as a versatile
spreadsheet program used for recording, manipulating, and storing numeric data. He emphasised
on Excel's adaptability, allowing users to customize it to match their preferences, making it an
indispensable tool across diverse industries.

Mr. Thamizharasu began the session with a detailed overview of the Microsoft Excel interface. He
highlighted the significance of the Ribbon, a central component that grants quick access to a wide
array of Excel commands. He further elucidated the Options dialogue window, a feature that
empowers users to customize various elements, including the Ribbon, formulas, proofing, and
saving preferences.
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The speaker underlined the omnipresence of Microsoft Excel across industries and reiterated its
versatility and relevance in the professional world. To ensure a firm grasp of the basics, he
meticulously covered key elements of the Excel interface, including the Quick Access Toolbar,
Formula Bar, Ribbon, Spreadsheet Grid, and Status Bar. Each tab within the Excel interface,
including File, Home, Insert, Page Layout, Formulas, Data, Review, and View, was explored and
demonstrated in detail.



Mr. Thamizharasu explained that a command is essentially an action that a user performs in Excel,
such as creating a new document or printing. Participants were also advised on font selection, with
Calibri being the default choice, while the professional font Times New Roman was suggested as
an alternative for specific use cases.
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Participants were exposed to various components of the Ribbon, a brief of which is presented

below:

v Ribbon Start Button : This serves as the gateway to various commands, including creating
new documents, saving existing work, printing, and customizing Excel options.

v" Ribbon Tabs: These tabs categorize similar commands together. For instance, the "Home"
tab is dedicated to basic commands related to formatting data, sorting, and finding specific
information within spreadsheets.

v" Ribbon Bars: Bars are used to group related commands together. For example, the Alignment
ribbon bar groups commands used for aligning data effectively.

Mr. Thamizharasu presented a comprehensive outlook of the Home tab, providing participants
with insights into each available option. This included font formatting options such as bold, italic,
underline, font size, text color, and alignment. The hands-on approach allowed participants to gain
practical knowledge of the fundamental formatting tools available in Excel.

The concept of worksheets was introduced, with Mr. Thamizharasu explaining that they are
composed of rows and columns. The intersection of a row and a column forms a cell, which is
used to record data. Each cell is uniquely identified using a cell address. Columns are typically
labeled with letters, while rows are numbered. Workbooks, which contain multiple worksheets,
were also discussed. Participants learned that workbooks typically have three default sheets named
Sheetl, Sheet2, and so on, but these can be renamed to better suit the content, such as "Daily
Expenses" or "Monthly Budget."



Mr. Thamizharasu shared a selection of vital keyboard shortcuts that can significantly enhance
efficiency when working in Excel.

Important Excel shortcuts

Ctrl+P used to open the print dialogue window
Ctri+N creates a new workbook

Ctrl+S saves the current workbook

Ctri+C copy contents of current select

Ctri+V paste data from the clipboard

SHIFT+F3 displays the function insert dialog window
SHIFT + F11 Creates a new worksheet

F2 Check formula and cell range covered

The session further delved into various features within Excel, including formatting data as a table,
utilizing cell styles, inserting and deleting cells, rows, and columns. Participants also learned
about formatting cell size, row height, column width, and visibility options, including the ability to
hide and unhide content. Additionally, attendees were educated on organizing sheets, renaming
them for clarity, moving or copying sheets, applying tab colors for better organization, and
exploring sheet protection. Sorting, working with pivot tables, and creating charts, including line
charts and pie charts, were also demonstrated.

Mr. Thamizharasu highlighted Excel's enduring status as the industry benchmark for financial
analysis and modeling across corporate finance functions. He emphasized that mastering these
fundamentals serves as the foundation for building confidence in Excel and for progressing to
more complex functions and formulas.
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Two fundamental approaches to calculations in Excel were presented:

1. Formulas: In Excel, a formula is an expression that operates on values within a cell or a
cell range. Mr. Thamizharasu elucidated various mathematical formulas, including SUM,
COUNT, COUNTA, SUMIF, AVERAGE, ROUND, PRODUCT, and ROMAN, providing
clear explanations and real-time examples for each.

2. Functions: Functions, which are predefined formulas in Excel, simplify complex
calculations by providing them with user-friendly names. The SUM function, a crucial example,
was explained in detail to illustrate its utility in aggregating values from selected columns or
TOWS.



Mr. Thamizharasu provided comprehensive explanations and real-time examples for essential
Excel formulas:

1. SUM: The SUM function, a fundamental Excel formula, aggregates values from selected
columns or rows within a specified range. Examples were provided to illustrate various use
cases.

Formula Example ~ Single Argument AVERAGE
=sum averages a group of numbers
SUM(number1, [number2], ...) PP T T ——"

=average(2,4,6) a4 5 10
=average(c9:d11) 12.4166667 3.5 20
=SUM(A1:A10) is an example of a single argument. g 30

2. AVERAGE: The AVERAGE formula calculates the average of data in a given range.
Real-world examples showcased its practical application.

3. COUNT: The COUNT formula was explained, highlighting its role in counting cells
containing only numeric values within a given range. Participants learned to adjust the formula
range to count rows effectively.

4. TRIM: The TRIM function was introduced as a tool to ensure that functions do not
return errors due to extra spaces in data. The example demonstrated how TRIM can eliminate
extra spaces within a cell.

A significant portion of the session was dedicated to creating hyperlinks in Excel and linking one
sheet to another. Real-time examples were showcased to effectively address participants' queries
and ensure a thorough understanding of this valuable feature.

In the session's concluding segment, Mr. Thamizharasu passionately encouraged all participants to
practice the various formulas and functions they had learned. He compared Excel to an ocean,
emphasizing the importance of continuous learning and improvement. In a professional and
motivational closing remark, he underscored the value of ongoing education and practice, leaving
participants inspired to explore the vast capabilities of Excel further.
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SARASWATHI. P
TRAINER, CLOUD REIGN TECHNOLOGHES

On the third and final day of the training program led by Ms. Saraswathi P of Cloud Reign
Technologies, Coimbatore, participants were exposed to various Google Workspace applications
and their extensive functionalities. The training was thoughtfully divided into two distinct parts,
with the first session focusing on Google Meet, Gmail, and Google Calendar, and the second
session covering Google Drive, Google Docs, Google Sheets, Google Slides, and Google Forms.
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In the initial session, Ms. Saraswathi illuminated the path to effectively engage in online events
through Google Meet. The participants were guided through the extra capabilities of Google Meet,
both in the desktop and mobile versions. This hands-on demonstration was instrumental in
ensuring that attendees were well-prepared to maximize their use of Google Meet for virtual
meetings and events.

Transitioning to Gmail, Ms. Saraswathi explored a wide range of topics. She initiated the session

by delving into the fundamentals of email. Then, the participants were provided with practical,

hands-on training to showcase the basic and advanced capabilities of Gmail. Key areas of focus

included:

v" Creating Teams in Gmail: Participants learned how to set up teams within Gmail,
streamlining communication within organizations.



v

v

Utilizing Google Snippets: This feature was demonstrated as a time-saving tool, allowing
users to create emails more efficiently by utilizing symbols and shortcuts.

Scheduling Messages: Participants were guided on how to schedule messages for future
delivery, allowing for timely communication even when they couldn't be present to send
messages in real-time.

Ms. Saraswathi also took time to elucidate the various settings options available within Gmail,
including:

*
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Language Preferences: She showcased the ease with which users can customize the
language settings to better suit their needs.

Undo Option: Participants were shown how to increase the visibility of the Undo option after
sending a message, providing a valuable safety net for those last-minute changes.

Font Size Adjustments: The session covered how to modify font sizes to cater to individual
preferences.

Signature Creation: Participants learned how to craft unique email signatures that leave a
professional mark.

Managing Multiple Email IDs: Ms. Saraswathi explained how to set up and manage
multiple email IDs with distinct signatures, eliminating the need for repetitive customization.

Moreover, the Label option was highlighted for its potential to filter emails based on sender and
recipient, simplifying email organization. Various other configuration options, including accounts
and import, filters, prohibited addresses, chat, and meet, were explored in detail.

Google Calendar was another essential aspect of the first session. Ms. Saraswathi shared insights
into the default calendar and demonstrated how to create additional calendars tailored to

individual needs. Key takeaways from this segment included:

v

v

Color-Coding Events: Participants discovered how to assign different colors to various types
of events for easy visual differentiation.

Scheduling Google Meet Links: The practical demonstration showed how to seamlessly
schedule Google Meet links for virtual gatherings.

Pop-Up Notifications: The session explained how to enable and manage pop-up notifications
during video calls.
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v" Scheduling Meetings with a Code: Participants were shown how to schedule meetings in
Google Calendar using a unique meeting code, illustrated through the example of the code
"CBP."

v" Customized Appointment Schedules: Attendees learned how to create appointment
schedules tailored to their specific preferences and set focus times for notifications when
selected slots were unavailable.

The significance of Google Drive in managing data access was also emphasized. Participants
gained insight into shared drives, a feature that enables multiple users to access data folders or
files while receiving automatic updates, streamlining collaboration and eliminating the need for
frequent file sharing.

The second session delved into content management using a suite of Google's productivity tools.
Notable highlights included:
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v' Automatic Saving in Google Docs: Participants learned that data is saved automatically in
Google Docs, obviating the need for manual saves after each modification.

v" Sharing Documents in PDF Format: Attendees discovered how to share documents as
PDFs via email, a convenient way to distribute and collaborate on documents.

v" Obtaining Approval for Document Edits: The session emphasized the importance of
approval for document edits, with options for allowing or restricting further changes.

v" Timer Button for Editing History: The Timer button was demonstrated as a valuable tool
for tracking team members' editing history, even if the system goes offline.

11



v' Explore Options:

Ms. Saraswathi explored the Explore feature, which allows users to

directly insert images from their web browser and translate entire documents into different

languages.

v' Activity Dashboard: The activity dashboard was introduced as a tool to monitor document
views and trends among team members.

v' Instant Meeting Start: A unique feature was mentioned, enabling participants to initiate an
instant meeting from Google Docs without manually creating a Google Meet link.

v" Google Sheets Capabilities: The session highlighted Google Sheets' ability to track edits and
send email notifications for changes.

In summary, Ms. Saraswathi P's training sessions offered a comprehensive understanding of
Google Workspace applications, enabling participants to effectively use these tools for enhanced

productivity and collaboration in their professional endeavors.
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comprehensive report

Dr. K. Ramya, the Programme Coordinator and Nodal Officer of AIU-AI-AADC, presented a

on the Seventh Short-Term Capacity Building Programme, themed

'Enhancing Office Productivity: Microsoft Office and G-Suite Training for Non-Teaching Staff.'

sincere gratitude to the

Dr. Ramya lauded the effectiveness of the session speakers, whose thoughtful deliberations
rendered the program productive, immensely useful, and perfectly timed. She also extended her

session speakers for generously sharing their valuable experiences with the

participants, enriching the program's impact and contributing to professional growth.

Participants List

S.No | Name Designation Institution/ Organization Name

1 Prakash Technician Sona College Of Technology

2 Mrs d Kavitha Computer Lab Instructor Panimalar Engineering College

3 Yogendra d Foreman Pes College Of Engineering Mandya

4 D.Dhanalakshmi Lab Technician Sona College Of Technology

5 Shaik Subhan Jr. Assistant Sasi Institute Of Technology And Engineering
6 Kurella Rekha Rajeswari Jr Assistant Sasi Institute Of Technology And Engineering
7 M. Sagaya Ponni Data Entry Operator Kongu Engineering College

8 P. Vasavi Viswanathan Administrative Assistant Sona College Of Technology

9 N.p.Kumar Lab Technician Sona College Of Technology

10 Edlina Thereza Salema Lower Division Clerk Don Bosco College Of Engineering

12



11 Velu.v Lab Technician Sona College Of Technology
12 Veronica Maria Colaco Assistant Registrar Don Bosco College Of Engineering
E Fernandes

13 Nithiyambal.v Assistant Administration Sona College Of Technology

14 Sushil Suresh Vichare Laboratory Assistant Thakur College Off Engg. & Tech.

15 R.Srinivasan Lab Technician Sona College Of Technology

16 Thangavel p Office Assistant Kongu Engineering College

17 M.Ephsiba Lab Assistant Vel Tech Multi Tech Dr Rangarajan Dr Shakuntala
Engineering College

18 Shakthivel v System Manager Kongu Engineering College

19 Rajalakshmi ¢ Lab Technician Sona College Of Technology

20 P. Ranjitha Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

21 A. Krishnamurthi System Administrator Kongu Engineering College

28 Kadiyala Mahesh Programmer Sasi Institute Of Technology And Engineering

29 R. Yuvaraj Lab Technician Sona College Of Technology

30 Saranya.s Multitask Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

31 Amit Ajit Naik Superintendent National Institute Of Technology Goa

32 Elackiya. P Multi Task Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

33 Kalaiselvan s Technical Assistant Kongu Engineering College

34 Md Azim Ansari Accountant Millat Teacher's Training College Madhubani

35 S.Ranjithkumar Lab Asst Kongu Engineering College

36 Sunila g d Mechnic Jn n College Of Engineering

37 Saramekala Karun Kumar Lab Assistant Sasi Institute Of Technology And Engineering

22 Ms.s.Soundariya Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

23 M.r.Hemalatha Secretarial Assistant Sona College Of Technology

24 Shahina Lab Instructor Sambhram Institute Of Technology

25 V. S. Sakthimurugan Laboratory Assistantt Kongu Engineering College

26 S.Maheswaran Technical Assistant Kongu Engineering College

27 Esakkiammal p Technical Assistant Sri Paramakalyani College

38 Ms. Teena Mascarenhas UDC Don Bosco College Of Engineering

e Braganza

39 Sunita Tikekar Technical Assistant KJ Somaiya Institute Of Technology, Mumbai

40 P.Sankar Technical Assistant Kongu Engineering College

41 Gopal Yadav Computer Operator Millat Teacher's Training College Madhubani

42 Yerroju s b Surya Prakash Lab Assistant Sasi Institute Of Technology And Engineering

43 S.Kavinkumar Technical Assistant Kongu Engineering College

44 K.N Ananadhakumar Technical Assistant Kongu Engineering College

13



45 Sumamma b n Lab Instructor Sambhram Institute Of Technology

46 Ramesh s Lab Technician Sona College Of Technology

47 Anbuselvi a Junior Assistant Sona College Of Technology

48 Hema Bridjet Roseline Secretary-Administrative St Joseph Engineering College

Fernandes

49 Manickasundaram Sr.Technical Assistant Kongu Engineering College

50 Panneerselvam J System Administrator Sona College Of Technology

51 K.Kuppusamy Network Admin Sona College Of Technology

52 Avinash Jain m Assistant Instructor Jnnce,Shivamogga

53 Kishor b Mugale Technical Assistant Kjsit Sion Mumbai

54 G Karthikeyan Lab Technician Sona College Of Technology

55 Gomathi.m Technical Assistant Kongu Engineering College

56 P.j. Jesuraj Secretarial Assistant Sona College Of Technology

57 Kavitha Office Staff Nandha Engineering College

58 Kariyappa k m Office Assistant Don Bosco Institute Of Technology

59 G.Girija Kumari Data Entry Operator Sri Vasavi Engineering College

60 G s ¢ v Padmakar Data Entry Operator Sri Vasavi Engineering College

61 Vijay Kumar Office Superintendent IHM, Lucknow

62 U.Sivasamy Technical Assistant Kongu Engineering College

63 Raghavendra s Lab Assistant Jnnce Shimoga

64 Muthulakshmi m Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

65 Indushree s Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

66 Mariyappan d Secretarial Asst Sona College Of Technology

67 Natarajan Instructor Panimalar Engineering College

68 P Manivannan Lab Instructor Panimalar Engineering College

69 Ramani p Technical Assistant Kongu Engineering College

70 Bandrevu Shirisha Lab Instructor Sambhram Institute Of Technology

71 K.T Arun Technical Assistant Kongu Engineering College

72 Mr.t.Karthik Lab Technician Sona College Of Technology

73 S.Senthil Kumar Data Entry Operator Kongu Engineering College

74 Gokulkumar S Technical Assistant Kongu Engineering College

75 Selvakumar.P Lab Technician Sona College Of Technology

76 Mythili R OA Kongu Engineering College

77 Abdul Salam J Sr. Technician Sona College Of Technology

78 Savitha S Data Entry Operator Kongu Engineering College

79 Ramasamy Systems Engineer Sona College Of Technology
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80 Karthick S Technical Assistant Kongu Engineering College

81 R. Thanagmuthu System Administrator Kongu Engineering College

82 Anil Jagannath Kate Laboratory Assistant Rajarambapu Institute Of Technology, Rajaramnagar

83 K.Kokila Technical Assistant Kongu Engineering College

84 R.Thangavel Lab Instructor Nandha Engineering College

85 M Nalinipriya Technical Assistant Kongu Engineering College

86 K.Gowri Data Entry Operator Kongu Engineering College

87 P Krishnamoorthi Lab Technician Sona College Of Technology

88 Biraj Rajendrabhai Desai Office Assistant International Relations Cell

89 Kannammal T A Lab Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

90 Yamunadevi G Technical Assistant Kongu Engineering College

91 Parameswaran Technical Assistant Kongu Engineering College

92 S P Pavan Kumar Senior Assistant University of Hyderabad

93 Rajesh O.Bedre Technical Lab. Assistant Shri Sant Gajanan Maharaj College Of Engineering,
Shegaon

94 Ramachandran.T Technical Assistant Kongu Engineering College

95 Sherly p j Administrative Assistant Christ (Deemed To Be University)

96 Gayathiri j Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

97 Vinjamuri Sri Pallavi Tr. Secretarial Assistant Sona College Of Technology

98 Varun Dubey Assistant Grade-i Rajiv Gandhi Institute Of Petroleum Technology

99 S.Dylin Raja Sheribha Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

100 Sasikala p Multitask Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

101 M.Priyanka Multitask Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

102 Sivasakthi.r Multitask Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

103 Durgadevi.v Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

104 Mr. Manik a. Yadav Hardware Assistant Rajarambapu Institute Of Technology, Rajaramnagar

105 Nitin Nandkumar Jagtap Computer Programmer Rit, Rajaramnagar

106 Kaviyadharshini.v Multi Task Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

107 Kumar d n Technical Helper Jn n College Of Engineering

108 Kokilavani v Technical Assistant Kongu Engineering College
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109 Saravanakumar v Net Admin Sona College Of Technology

110 Gaurav Chauhan Library Assistant Shri Shankaracharya Mahavidyalaya, Bhilai

111 Devidraju Galimotu Lab Assistant Shri Shankaracharya Mahavidyalaya, Bhilai

112 Ravichandran Vishnu Data Entry Operator Shri Shankaracharya Mahavidyalaya, Bhilai

113 Sachin Dhagat Office Assistant Shri Shankaracharya Mahavidyalaya, Bhilai

114 Usha b Instructor Jn n College Of Engineering

115 Heema Verma Assistant Accountant Shri Shankaracharya Mahavidyalaya, Bhilai

116 Soniya Verma Accountant Shri Shankaracharya Mahavidyalaya, Bhilai

117 Shweta Khobragade Office Assistant Sri Shankaracharya Mahavidyalay Jinvani Bhilai

118 S.Jenifer Multi Task Assistant Avinashilingam Institute For Home Science And

(Temporary) Higher Education For Women

119 Aniruddha Ashok Patil Laboratory Assistant Rajarambapu Institute Of Technology, Rajaramnagar

120 Pallavi Baliga j p Instructor Jnnce

121 Sunil Vilasrao Shelke Clerk Shri Sant Gajanan Maharaj College Of Engineering,
Shegaon

122 Rushikesh Shivaji Patil Lab Assistant (Workshop) Rajarambapu Institute Of Technology, Rajaramnagar

123 Shri Lokesh Bhatnagar System Superintendent - Grade | Rajiv Gandhi Institute Of Petroleum Technology

2

124 Sameer d. Sadakale Lab Assistant Rajarambapu Institute Of Technology, Rajaramnagar

125 Amit Kumar Bajpai Assistant-Iii Rajiv Gandhi Institute Of Petroleum Technology

126 Anil Kumar Jena Superintendent System i Rajiv Gandhi Institute Of Petroleum Technology

127 Suresh Kunar Office Attendant Rajiv Gandhi Institute Of Petroleum Technology

128 Raghavendra k Instructor Jawaharlal Nehru National College of Engineering

129 V d Pavan Instructor Jawaharlal Nehru National College of Engineering

130 Hanumanthappa s Peon Jawaharlal Nehru National College of Engineering

131 Anupriya Senior Assistant Aryabhatta College

132 Kiruthika . S Office Assistant Kongu Engineering College

133 Nandhini | Data Kongu Engineering College

134 Jayakumar m Senior Technician Sona College Of Technology

135 Chitra j Lab Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

136 Banupriya m Multitask Asssistant Avinashilingam Institute For Home Science And
Higher Education For Women

137 Gunvant Dattu Chavan Laboratory Assistant Rajarambapu Institute Of Technology, Rajaramnagar

138 S. Sudha Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

139 Famina Nazianzeno Lower Division Clerk Don Bosco College Of Engineering

Fernandes
140 Vishal Vishnu Khandekar Laboratory Assistant K j Somaiya Institute Of Technology, Sion ,Mumbai
141 Nandhasri.g Lab Technician Sona College Of Technology
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142 Sivaranjani s Lower Division Clerk(LDC) Avinashilingam Institute For Home Science And
Higher Education For Women

143 Ganesh Ramrao Galugade Laboratory Assistant Rajarambapu Institute Of Technology, Rajaramnagar

144 Ganesh Shamrao Madale Laboratory Assistant Rajarambapu Institute Of Technology, Rajaramnagar

145 Bharati Tilottam Sansare Lab Assistant KJ Somaiya Institute Of Technology, Sion ,Mumbai

146 Kavita Amar Pashte Technical Asst. Kjsit,Sion

147 Durgad Lab Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

148 Royena Belinda Barbosa LDC Don Bosco College Of Engineering

149 S.Renu Priya Lab Assistant Ksr Institute Of Engineering Technology

150 S.Abiviruthi Lab Assistant Ksr Institute Of Engineering Technology

151 Yuvraj Prabhakar Chavan Technical Assistant K. J. Somaiya. Institute of Engineering and
Information Technology

152 Menisha a Lab Technician Sona College Of Technology

153 Bhavin Shah Asst.Director- Industry Parul University

Academia Partnership Cell

154 A.S.Geetha Programmer Ksr Institute Of Engineering Technology

155 Tamilarasi Library Assistant Sona College Of Technology

156 Suryaa R S Office Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

157 A.Santhi Office Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

158 Priyadharshini A Laboratory Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

159 G. Uma Multi Task Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

160 A. Sivaranchini Stenographer Avinashilingam Institute For Home Science And
Higher Education For Women

161 Kumar K Office Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

162 Shobika G Multitask Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

163 P Jegatheswari Multi Task Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

164 Dhanabagyam k Multitask Assistant Avinashilingam Institute For Home Science And
Higher Education For Women

165 Kumaresan C Tr.Lab Technician Sona College Of Technology

166 A. Prabu Technician Sona College Of Technology
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Sample Certificate

=

A lingam Institute for Home Sclence and Higher Education for Women
i Deemed to be University Estd.uis 3 of UGC Act 1956, Category A by MHRD
Re-accredited with 'A++ Grade by NAAC. CGPA 3.65/4,Category | by UGC
Coimbatore-641043, TamilNadu, India

'shlllngam Institute - Academic & Administrative Development Centre

(AIU-AJ-AADC)

- Al - AADC/ 2023 - 2024 / 07/ 095

CERTIFICATE OF PARTICIPATION

This is to certify that

Mrs. Sherly P J
Administrative Assistant, Internal Quality Assurance Cell
Christ (Deemed to be University)
has participated in the Seventh Short-Term Capacity Building Programme on
2 Productivity: Microsoft Office and G-Suite Training for Non-Teaching Staff
vil nstitute — Academic & Administrative Development Centre (AIU - Al- AAD

2023 and her performance was Excellent.
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Avinashilingam Institute for Home Science and Higher Education for Women

AIU-AI-AADC

7™ Capacity Building-Program on
‘Enhancing Office Productivity:
Microsoft Office and G-Suite Training for Non-Teaching Staff’

30.09.2023 - 02.10.2023

Day/Date Sessions Trainer/Resource Person

Day 1 Microsoft Word and PowerPoint Praveen Poulose E

30.09.2023 Engineer - Cyber Security Group

Saturday Quadrasystems.net (India) Private
Limited
Email : praveen.p@quadrasystems.net
Mobile : 7812025576

Day 2 Microsoft Excel and Outlook Thamizharasu C

01.10.2023 Manager - Strategic projects

Sunday Quadrasystems.net (India) Private
Limited
Email : thamizharasu.c@quadrasystems.net
Mobile : 96772 09627

Day 3 G-Suite Applications Arulprakash G

02.10.2023 Manager - Business & Operations

Monday Cloud Reign Technologies

Email : arul@education.cloudreign.in
Mobile : 9865176677

Saraswathi. P
Trainer, Cloud Reign Technologies

Email : sara@biz.cloudreign.in
Mobile : 89258 35494




Avinashilingam Institute for Home Science and Higher Education for Women
. Deemed to be University Estd. u/s 3 of UGC Act 1956, Category A by
MHRD Re-accredited with 'A++' Grade by NAAC.CGPA 3.65/4,
Category I by UGC Coimbatore-641 043, Tamil Nadu, India

-'!"

4  AIU Avinashilingam Institute
Academic and Administrative Development Centre
| (ATU-AI-AADC)

'VII Short Term Capacity Building Programme
on

Enhancing Office Productivity:
Mlcrosoft Office and G-Suite Training
. for Non-Teaching Staff

\‘\___30.09.2023 £602.10.2023

Mode : Online

Hands-on n \ 5 . .
i .S.e >slons S ReglsTr'aflon |
Activities ) g || oe— FREE S
Demontrations € S
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ABOUT THE INSTITUTE

Avinashilingam Institute for Home Science and Higher Education for Women -
the epitome of higher education is one of the premier institutions in India well
known for its commitment towards the empowerment of women through value
based and holistic education. The institute follows educational ideals of Sri
Ramakrishna, Holy Mother Sri Saradamani Devi, Swami Vivekananda and
Mahatma Gandhiji. The institute is one of the significant contributions of
Padma Bhushan, Dr. T. S. Avinashilingam, an illustrious educationist,
freedom-fighter and Gandhian and Dr. Rajammal P. Devadas, the world-
renowned nutritionist.

The Institute had its humble beginning in the year 1957 as Sri Avinashilingam
Home Science College for Women and has been conferred the Deemed to be
University by MHRD in 1988. Few of the recent accolades of the Institute
includes: A++ with CGPA of 3.65/4 by NAAC; 84t Rank in NIRF, 5th Rank
under the category of ‘University & Deemed to be University (Govt. & Govt.
Aided) Technical’in ARITA —2021.

Presently, the institution is progressing towards ‘beyond-excellence’ under the
able guidance and leadership of Dr.T. S. K. Meenakshi Sundaram, Managing
Trustee and Chancellor, Dr. V. Bharathi Harishankar, Vice Chancellor
and Dr. S. Kowsalya, Registrar.

ABOUT ASSOCIATION OF INDIAN UNIVERSITIES

T LA O A gy TR

o

Association of Indian Universities (AIU) is an apex inter university representative
body of universities and other higher education institutions in the country.
Established in 1925 as the Inter University Board (IUB) of India, it acquired its
legal status as a registered society in 1967 under the Societies Registration Act
1860 and was rechristened as Association of Indian Universities (AIU) in 1973. ———
AIU is the second oldest university association in the world next to the :
' Association of Commonwealth Univessities which was established in 1913.
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It has the distinct feature of having the largest network of universities and other HEIs
under its ambit with 964 Members which includes 16 Associate Members of Foreign
Countries. The membership of AIU includes all types of universities e.g.,
Conventional Universities, Open Universities, Deemed to be Universities, State
Universities, Central Universities, Private Universities and Institutes of National
Importance.

In addition to Indian Universities, Universities / Institutes from Bangladesh, Bhutan,
Republic of Kazakhstan, Malaysia, Mauritius, Nepal, Thailand, United Arab Emirates
and United Kingdom are its Associate Members. Since its inception AIU has played a
very significant role in the development of Education in the Country.

Some of the eminent scholars and visionary leaders like Dr Sarvepalli Radhakrishnan, Dr
Shyama Prasad Mukherjee, Dr Zakir Hussain, Sir. A L. Mudaliar have given leadership
to AIU. During such a long journey, AIU has carved a niche for itself by serving the
Ministry of Education, Govt. of India as a research-based policy advisory body. Being
an apex institution, it constitutes an integral part of all major decision-making
committees and commissions in the country

As an academic ‘think tank’ organization, AIU supports the Government as research-
based policy advisory body with the wider mandate of taking up research projects on
higher education policy and capacity building. It also acts as a bureau of information
on higher education; liaise with international bodies and universities for
internationalization of Indian higher education among many others. The Vision of
AIU is to emerge as a dynamic service and apex advisory organization in India by
undertaking initiatives and programmes which could strengthen and popularize Indian
higher education as leading-edge system in the world and promote greater national and
international collaboration in Higher Education, Research, Extension, Sports, Youth
" and Cultural Activities.

It is bestowed with the mission of promoting and representing the Indian Universities

and other higher education institutions through strong liaison with the government and

National/International organizations, sister associations world over and establish

liaison between/ among universities through active support, cooperation and
" coordination among the member universities and all its stakeholders for quality- ===

.. education, research and other academics and extension activities.
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ABOUT THE CENTRE

AIU-Avinashilingam Institute - Academic and Administrative Development
Centre (AIU-AI-AADC) has been initiated by the institute in association with
Association of Indian Universities (AIU) as a step towards training the human
resources of higher education institutions. The specific objectives of the centre
are:

» Facilitate learning through Performance Improvement Programmes for
different groups (Administrators/Teaching Faculty/Non-Teaching
Research Scholars/Technical Personnel) towards progression based on their

career stages.
= Enable continuous learning through rigorous need-based training
sessions

* Sensitize stakeholders on recent developments in higher education
system in the country and across the world.

*» Equip academic / administrative / technical / information personnel
with the requisite skills on ICT to handle their work effectively.

»= Develop integrity and professional ethics among higher education
personnel.

=  Strengthen the human capital of the country with right attitude,
skills, and knowledge

VISION

To facilitate value-based transition towards changing higher education
‘ecosystem through continuous capacity building.

AL O R e

o

MISSION

" Toimpart ICT enabled training to human resources of higher education =N
institutions thereby preparing themselves towards Education 5.0. Se=aaeasS
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ABOUT THE PROGRAMME

In the modern higher education landscape, non-teaching staff play a crucial but

- often overlooked role in ensuring the efficient operation of universities and

_ colleges. They manage administrative tasks, provide vital student support, and
facilitate communication between departments. Proficiency in productivity suites
like Microsoft Office and G Suite has become essential for these unsung heroes. A
three-day capacity- building program titled "Enhancing Office Productivity:
Microsoft Ofﬂce and G-Suite Training for Non-Teaching Staff" has been designed to
cater to their specific needs. This program equips non-teaching staff with essential
skills to maximize the potential of Microsoft Office and G-Suite tools, enhancing
proficiency in Word, Excel, PowerPoint, Google Workspace, and Google Drive.
Participants gain practical insights and techniques to streamline tasks, encourage
collaboration, and boost overall productivity. These skills enable them to excel in
their roles, contributing significantly to the success of academic institutions.

OBJECTIVES

» Comprehensive Skill Development: Ensure participants acquire a comprehensive
understanding of Microsoft Office and G Suite, including core applications such
as Word, Excel, PowerPoint, Google Docs, Sheets, and Slides.

» Efficiency and Collaboration: Enable participants to use these productivity suites
efficiently to create, edit, and share documents collaboratively, fostering
~ effective communication and teamwork within higher education institutions.

Advanced Proficiency: Equip participants with advanced features and techniques
within-these suites, allowing them to streamline complex tasks, data
management, and presentation design.

;ggqggyfﬂ!iﬁf‘{!&:?im}

~ » Productivity Enhancement: Provide participants with productivity tips and
strategies to optimize their work processes, manage time effectively, and——_
prioritize tasks efficiently within the university or college setting. Se——

s
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> Probem-Solving Skills: Enhance the partmpants problem soIvmg abilittesby ™
addressing common challenges and errors related to Microsoft Office and e, .
Suite applications, ensuring smooth and error-free operations. 24N
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PROGRAMME SCHEDULE

Day 1: Microsoft Word and Powerpoint

Session 1: Introduction to Microsoft Word

Overview of Microsoft Word and its significance in document creation.
Navigating the Word interface: Ribbons, Tabs, Quick Access Toolbar.
Creating, saving, and opening documents.

Document organization: Headers, footers, page numbers, and section breaks.

Session 2: Document Formatting and Efficiency

Basic and advanced text formatting: fonts, styles, themes, and formatting painter.
Working with paragraphs: line spacing, indentation, bullet points.
Page layout options: margins, orientation, page breaks.
Efficient use of tables and lists.
Session 3: Advanced Word

Exploring advanced features in Word, such as styles, mail merge, and forms.
Advanced formatting options: columns, text boxes, and drop caps.
Collaboration tools: Comments and track changes.

Session 4: Introduction to PowerPoint

Introduction to Microsoft PowerPoint and its role in creating presentations.
Navigating the PowerPoint interface: Ribbons, Tabs, Slides, Slide Master, Slide
Sorter.

Creating engaging presentations, adding slides, content, and multimedia, Slide
‘transmons and animations

Using speaker notes and rehearsing presentations.

Day 2: Microsoft Excel and PowerPoint

Session 1: Introduction to Microsoft Excel == - ===

> Microsoft Excel and its apphcatlons in data managemcnt and ana1y51s. e SR
»Navigating the Excel interface: Ribbons, Tabs, Quick Access Toolbar. . S
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Session 2: Data Management and Analysis using Excel

Formulas and functions: Understanding basic and advanced functions.
Data entry and organization: Sorting, filtering, and conditional formatting.
Tips for efficient data management and analysis.

Session 3: Advanced Excel

Exploring advanced features in Word, such as styles, mail merge, and orms.
Advanced formatting options: columns, text boxes, and drop caps.
Collaboration tools: Comments and track changes.

Session 4: Outlook and OneDrive

Introduction to Microsoft Outlook: Managing emails, calendars, and tasks
efficiently.

Leveraging OneDrive for cloud-based document storage, sharing, and
collaboration.

Integration and synchronization between Outlook and OneDrive for
seamless workflow.

Day 3: G-Suite Applications
Session 1: Introduction to G Suite

Overview of Google Workspace and its significance.
Navigating the G Suite interface: Gmail, Google Drive, Calendar

~Setting up and managing your G Suite account.

Session 2: Efficient Email Management with Gmail

‘Mastering Gmail for effective email communication
Organizing and managing emails with labels, filters, and categories. ————
E-Mail Etiquettes SE———
Utilizing advanced features likeGoogle Chat and Meet for real tlme =
communication. e _‘_‘_ = ‘ e
N



Session 3: Collaborative Document Creation with Google Docs

» Creating, editing, and formatting documents in Google Docs.
» Version control and revision history.
» Real-time collaboration and commenting features.

Session 4: Data Management and Collaboration with Google
Sheets

» Data entry, organization, and analysis using Google Sheets.
» Collaborative data editing and sharing.
» Creating charts and graphs for data visualization.

LIST OF RESOURCE PERSONS

s PRAVEEN POULOSE E, Engineer- Cyber Security
. Group Quadrasystems.net (India) Private Limited

"1“* THAMIZHARASU C, Manager — Strategic projects

£y B R e S

* Quadrasystems.net (India) Private Limited
% ARULPRAKASH (G, Manager- Business & operations
Cloud Reign Technologies

e ey

% SARASWATHI P, Trainer, Cloud Reign Technologies—————
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TARGET PARTICIPANTS
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taff (non-teaching staff) of Higher Education Institutions

Online

30.09.2023 to 02.10.2023 (3 Days Programme)

REGISTRATION

STRATION LINK

https://forms.gle/imzqa91rAPafRLBY6

: FREE

AT ADVISORS
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I.S. K. MEENAKSHISUNDARAM, Managing Trustee & Chancellor
BHARATHI HARISHANKAR, Vice Chancellor
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https://forms.gle/imzqa91rAPafRLBY6
mailto:aadc@avinuty.ac.in

Special thanks to:
Al Advisors
e Dr.T.S. K. Meenakshisundaram, Managing Trustee & Chancellor

e Dr. V. Bharathi Harishankar, Vice Chancellor
e Dr.S. Kowsalya, Registrar

AlU Advisors
e Dr. Pankaj Mittal, Secretary General, AlU

e Dr. Amarendra Pani, Joint Director & Head, Research Division, AlU

We extend our heartfelt gratitude to all the Invited Guests, Resource Persons, HET's,
Coordinators, Committee Members, Technical staff for their unwavering support!

We sincerely thank each attendee for their participation and enthusiasm!

Welcoming you all again in the future!

g — -

Avinashilingam Institute for Home Science and Highe

Deemed 1o be University Estd. uis 3 of UGC Act

AlU-Avinashilingam Institute-Acad
(Al
Inaugurated on Frid

Dr. K. Ramya
Nodal Officer, AIU-AI-AADC
AlU - Avinashilingam Institute- Academic & Administrative Development Centre
Avinashilingam Institute for Home Science and Higher Education for Women
Coimbatore - 641 043, Tamil Nadu, India.
e-mail ID : aadc@avinuty.ac.in
Mobile : 8072202927
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